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Introduction
WinU is a Windows 95 menu system with timeout and security access features. It is 
excellent for parents that want to allow their children to use only certain software on the 
family PC, without worrying that Junior might delete the household tax records.    It is 
also ideal for computer stores that want to let the shopping public try their featured 
software without allowing access to the entire computer.    WinU lets you set the amount 
of time that shoppers (or children) can use a program.    It allows a warning "grace 
period,"    with a custom warning message that you can set, before it terminates the 
program.    Vendors and businesses will appreciate the File Logging feature, which 
tracks exactly when each programs was run, and for how long.    And WinU allows you 
to use any Windows bitmap as its fullscreen background image.    Use your company 
logo or sales information, or just your favorite pretty picture.    Or put the image in the 
top half and the menu buttons on the bottom, to give an unobstructed view of the 
picture.



How To Order WinU
Thank you for trying WinU.    You are welcome to test the fully-functional evaluation 
version for 30 days.    That is, you can run the program on 30 different dates.    These 
dates do not have to be consecutive calendar days.    If you don't run WinU on a 
particular date, it doesn't count against your 30 days.    This gives you plenty of time to 
try it under actual working conditions on your own system, to see if it meets your needs. 
After the trial period, you must either purchase WinU or remove it from your system.
 
To order, send $29.95 (plus shipping, see below) to:
 
Data Outlet
P. O. Box 37278
Richmond, VA 23234

Payment: You can pay with cash, check, money order, MasterCard, or Visa.
Shipping: Please enclose $5 for shipping and handling.
Outside North America: Please add an additional $6 overseas shipping surcharge.

With a MasterCard or Visa you can also order WinU by phone, either directly from Data 
Outlet at 804-768-0424 (noon to 8:00 Mon-Thu) or through Data Outlet's toll-free 
telephone order-taking service at 800-242-4775 (weekdays 7 to 6 Central time), or 24 
hours a day by fax at (713) 524-6398 or on CompuServe at 102676,667.    Include card 
number, expiration date, and name as it appears on the card.

If you order with a MasterCard or Visa by phone at 804-768-0424, you'll be given your 
registration number immediately so you can get rid of those reminder screens and 
limitations right away.    Or simply mail in your card number and expiration date.

When you order, you'll get a copy of the most recent version of WinU, a registration 
number that will turn off the reminder screens and remove the limitations of the 
evaluation version, a printed manual, support, and update notices.

You will also get a FREE copy of Reverend Lowell's Treasury of Humor, Volume 1: 
"He Who Laughs, Lasts!" Reverend Lowell's Treasury contains thousands of 
humorous anecdotes collected by Reverend Lowell during his long career as an 
ordained minister.    After thirty years of public speaking from the pulpit, the podium, and 
on television, he has amassed over 200,000 items, and Reverend Lowell's Treasury 
represents the "cream of the crop."    These are Reverend Lowell's favorite funny 
stories, revealing quotes, interesting anecdotes, and zingy one-liners.    And there's 
nothing that would be unsuitable in any public setting.    There are plenty of items to 
choose from.    Each volume of the Treasury covers a different topic, and contains at 
least as many items as you'd find in a full-size book.    Many are illustrated in color or 
black-and-white.    You can search for any item by keyword or first line.    Or simply 
browse through every item page by page.



The File Menu
Password:  First you are asked for the current password.    Then the Change Password
dialog lets you change it to a new password.    Give the new password twice, once on 
each line.

Configuration Parameters: The Configuration dialog is where you set the background 
bitmap, indicate which WinU functions require a password, set up a logging file to 
record which apps were run when, and toggle Convenience Mode.

Applications On Buttons: The Applications dialog is where you add, change, or delete
applications and their timeout parameters.

Shut Down The Computer: In Security Mode, WinU covers the entire screen.    With no
access to any other Windows 95 controls, this is how the user can shut down the 
computer.    A password is required (if this is set in the Configuration Parameters).

Exit: This is how the user exits from WinU.    A password is required (if this is set in the 
Configuration Parameters).



The Help Menu
The Help menu has two items: Help and About WinU.

Use the Help item (or press F1) to get on-line help about WinU.

The other item, About WinU, is a typical About box.    It gives the WinU version number 
and copyright information.



Notices
TECHNICAL SUPPORT: For technical support contact the publisher, Data Outlet, 
through CompuServe email (102676,667), Internet email 
(102676.667@compuserve.com) U. S. Mail (P. O. Box 37278, Richmond, VA 23234), or 
phone (804-768-0424 noon to 8:00 Mon-Thu).

VERSION: WinU version 1.01

SYSTEM REQUIREMENTS: Requires Microsoft Windows 95

SOFTWARE LICENSE: Anyone is welcome to distribute unregistered evaluation copies 
of WinU, in its entirety as distributed with this file, subject to these conditions:

1) None of the files in this package may be modified or deleted.
2) Vendors or distributors who generally pay royalties must notify the publisher, author 
or author's representative that they are distributing WinU.
3) Vendors or distributors must stop distributing WinU if asked to do so by the publisher,
author or author's representative.

In addition, the attached VENDINFO data record is hereby incorporated by reference.    
Any distribution satisfying all the distribution requirements expressed in that data record 
is hereby authorized.

After purchasing, copies of WinU may not be distributed.    Only one user is authorized 
to use the program, on one computer.    It may not be used in a multi-user setting 
without first obtaining a site license.    It may be duplicated only for the purpose of 
making a reasonable number of backup copies.

WARRANTY: Neither the author nor the publisher make any warranty of any kind, 
expressed or implied, with regards to the software or the documentation.    Neither the 
author nor the publisher shall be liable in any event for incidental or consequential 
damages in connection with, or arising out of, the furnishing, performance, or use of this
software package.

COPYRIGHT: All WinU software and documentation copyright 1995 Barry Smiler.

CONTACTING THE AUTHOR:    Barry Smiler, the author of WinU, can be contacted 
through CompuServe email (72340,375), Internet email 
(72340.375@compuserve.com), U.S. mail (Bardon Data Systems, 1023 Key Route 
Blvd., Albany CA 94706), or phone (510-526-8470).

CONTACTING THE PUBLISHER: Data Outlet, the publisher of WinU, can be contacted 
through CompuServe email (102676,667), Internet email 
(102676.667@compuserve.com) U. S. Mail (P. O. Box 37278, Richmond, VA 23234), or 
phone (804-768-0424 noon to 8:00 Mon-Thu).





Uninstalling WinU
WinU tries to be considerate of the rest of your Windows system. It just copies its own 
files to the directory you specify, and adds its icons to the Start button group you specify.
If you decide to uninstall, just delete the specified files and icons.

Related Topics:
Installing WinU 



Installing WinU
To install WinU, run the included program install.exe that comes with WinU.    It will ask 
you for the directory you'd like to install into, the Start button group name you prefer, 
and whether you'd like WinU to run at startup.    WinU will not install anything to any 
other directory, other than the one directory you specify.    It will not change any system 
files.    If you choose to uninstall, simply delete this one directory, plus any Start button 
shortcuts that point to it.

WinU includes the following files which are installed to the directory you choose:

winu.exe the WinU program, file 1
winu2.exe the WinU program, file 2
winu.hlp the documentation, in Windows help file format
readme.txt overview and installation instructions
whatsnew.txt new features and revision history
install.exe WinU's installer

Related Topics:
Uninstalling WinU 



Quick Start
There are three steps to setting up WinU:

1) Set the password which you probably did already, at startup.

2) Configure the system by using the File menu item Configuration Parameters to 
display the Setup Options dialog.

3) Add programs by using the File menu item Applications On Buttons to display the 
WinU Applications dialog.

You'll also want to give some thought to security considerations, and understand the 
Convenience Mode option.

Here are a few more things to consider:

In Security Mode...    there's a countdown timer in WinU's menu bar, so the user always
knows how much time is left    ... if a button app is running at WinU exit, the button app 
is terminated    ...    you can't shut down the computer when WinU is running (oh, OK, 
yes, the power switch still works)    ...    you can't exit from WinU improperly (it restarts)  
  ...    WinU won't run smaller than fullscreen, and when set up properly the user can't 
access the Start button, task bar, desktop, Explorer, nothing except what you've 
provided    ...    You can only run one program at a time.    When you click on a new 
button, the previous app closes    ...    You can't restart a program sooner than the restart
time interval    ...    If you minimize a WinU button app, Winu reopens it    ...    WinU 
always tries to start apps fullscreen.    The user has the option of clicking the "normal 
size" titlebar button ... The current app cannot get buried under the WinU window; WinU
keeps it on top ...    Those big-font warning message boxes time out in two minutes; they
don't hang around on the screen looking like something's broken.    



Setting The Password
The first time you start WinU, it asks you for a password.    This password is saved 
permanently (note: the evaluation trial version of WinU does not save the password 
between sessions) so you never need to enter one again if you don't want to.    
However, you can change the password at any time with the Password item on the File
menu.



Configuring WinU
Use the File menu item Configuration Parameters to display the Setup Options 
dialog.    There are five parts to this screen.    They are:

Bitmap Image: WinU has its own "built-in" background image, or it can display any 
Windows bitmap as the background image by giving its file name here.    Also, indicate 
here whether you want to show the image fullscreen behind the menu buttons, or 
unobstructed in the top half of the WinU screen.    You can type it in, or use the Browse 
button, or "drag and drop" bitmap image filenames from Explorer onto this dialog.    It will
appear as the bitmap file name.

Image Display Mode: This sets the display mode for the background bitmap image.    
The best mode for color images is usually Mode 2.    However, on some systems Mode 
1 or Mode 3 may work better.    Try it and see.

Password: Is a password required to shut down the computer?    To exit WinU?    To 
change WinU's configuration and applications list?    Consider that if it's easy for the 
user to exit or bypass WinU, or shut down and restart the computer, this may provide an
access route around WinU's security features.    If security is your goal, you may also 
want to place a shortcut to WinU in the Startup folder, so WinU is always activated when
Windows 95 starts its GUI desktop.

Log To File: When checked, WinU adds a line to your chosen log file noting the start 
time and duration of each application run from WinU.    It also notes the start and end 
times for this WinU session. (Note: the evaluation trial version of WinU does not allow 
logging to file.)    In "convenience mode" application start times are logged but not end 
times. You can type it in, or use the Browse button, or "drag and drop" any filename 
from Explorer onto this dialog.    If it's not a bitmap (see above) it will appear as the log 
file name.

Convenience Mode: WinU has a convenience mode    in which it can be run smaller 
than fullscreen.    Since this allows the user to bypass WinU and run programs from the 
Start button, Explorer, etc, in "convenience mode" WinU's security features are 
suspended.    This turns WinU into a convenient way of launching applications from a 
handy list.    "Convenience mode" is also very useful when setting up WinU.    Since 
WinU is smaller than fullscreen, it's easier to navigate through the rest of your system to
find the programs you want to add to WinU.    (Note: the evaluation trial version of WinU 
allows you to use "convenience mode" for setup, but does not allow applications to be 
launched from buttons.)

Activate/Disable Boot-Time Function Keys: A possible security hole is the use of the 
function keys when the computer boots.    For example, at boot time F4 starts your 
previous version of DOS, and F8 brings up a menu of options including bare DOS, "safe
mode," and various other ways to continue.    To enhance security, disable these boot-
time function keys by clicking this button.    To re-activate, click it again.    The button title 



tells you the current setting.



Adding Or Changing Programs
WinU displays each program name on a button.    To run that program, the user clicks 
the button.    To add, change, or delete a button, bring up the Applications dialog on the
File menu, and enter this information:

File to run: This is the full filename of the program. You can type it in, or use the 
Browse button, or "drag and drop" any filename from Explorer onto this dialog.    If it's 
not an icon file (see below) it will appear as the file to run. 

Command parameters: Give any command-line parameters or switches needed by the
program.

Initial Directory: This is the starting directory for this program.    If you don't list 
anything, the WinU's current directory is used as the program's initial directory.

Icon File: If you'd prefer an icon other than the usual one, give its name here. You can 
type it in, or use the Browse button, or "drag and drop" .ico (icon) filenames from 
Explorer onto this dialog.    It will appear as the icon file.    You can also list almost any 
Windows program, and even some DLLs.    Whatever you list, the first icon in the file will
be used.

Button Text: This is the title text to be displayed on the button.    You've probably 
noticed that all buttons are the same size.    This size is determined by the length of the 
longest button title text.

Warning Message: This is your customized warning message to be displayed for this 
program.    If you don't provide a message, a generic warning message is used.    It's 
helpful to indicate in your warning message just how much time remains before 
termination.    Your message can be up to 300 characters long.

Minutes Until Warning: This is the number of minutes until the warning message is 
displayed.    Set this to zero if you don't want any time limits for this program

Minutes Until Termination: This is the number of minutes until the program is 
terminated.    It must be a larger number than the Minutes Until Warning.    For example, 
you might set 10 Minutes Until Warning, and 14 Minutes Until Termination.
Set this to zero if you don't want any time limits for this program.

Minutes Before Application Restart Allowed: It's sometimes useful to be able to set a
"waiting period" before an application can be restarted after termination.    For example, 
if a parent sets up Junior's game with 30 Minutes Until Termination, what's to prevent 
Junior from simply restarting the game right away?    Just set 60 Minutes Before 
Application Restart Allowed and Junior will have to do something else for an hour.    
Maybe even homework...



App Requires MS-DOS Mode: Check this box if the program has been configured to 
run in "MS-DOS Mode."    You'll hardly ever need to do this.    Almost all DOS programs 
run just fine under a normal Windows 95 DOS session.    But a few older or ill-behaved 
DOS programs need to run in what's called "MS-DOS Mode."    In this mode, Windows 
95 starts the program and then shuts itself down almost entirely.    The DOS program 
has the use of the entire machine.    When the DOS program exits, Windows 95 reboots.
This creates some security considerations that deserve careful thought before you 
include such a program in a security-oriented environment like WinU.

After you give this information, click the Add App button to create a new listing.    To 
delete an app, select one from the list and click the Delete App button.    To change an 
app, select one from the list, change its information, and click the Change App button.   
There are also buttons to move an app up or down in the list.

To get you started, there's also a Find All Apps button.    This will list every exe, com, 
bat, and pif file in your system.    You can scroll through this list, and when you find an 
app you want to add, select it from the list and click on the Add This App button.    It will
be added with default parameters (which you'll probably want to customize with the 
Change App button).    Click the Done button when you're finished with this list.



Security Considerations
WinU can control many, but not all, ways that a user might try to access your system.    
Here are some things you should do to provide further protection.
 
Put A Shortcut To WinU In Startup: WinU offers to do this automatically when you first
install it.    If you didn't do so at that time, consider putting a shortcut to WinU in the 
Startup folder.    That way, if the system is turned off at the power switch, WinU will 
become active instantly when the Windows 95 desktop boots next time.    If you're 
comfortable using Explorer to create a shortcut to winu.exe in the Startup folder, that's a
fine way to do it.    If not, here are step by step directions:

a) Click the Start button
b) Select the Settings menu item.    A sub-menu appears.
c) In the sub-menu, select Taskbar
d) The Taskbar Properties dialog comes up
e) Select the tab labeled "Start Menu Programs"
f) Under Start Menu Programs, click the Add button 
g) If you know the full directory path to the winu.exe program, type it into the command 
line.    Otherwise, click on the Browse button to find it and select it.    Either way, the full 
path to winu.exe winds up in the command line. When it's there, press Next.
h) When you press Next, the Start menu's directory structure appears.
i) Scroll down until you see the Startup folder, and select it.
j) Now you'll be asked to give a name for this new shortcut.    Pick your favorite name, 
and click on the Finish button.
k) Back at the Taskbar Properties dialog, click OK.

Close All Other Programs: WinU doesn't mind when other programs run at the same 
time it is active, but before you start Winu in Security Mode, you should still exit from all 
other programs.    This is because Windows lets the user Alt+Tab to any running 
program, and this may provide a way to bypass WinU's security.    (Alt+Tab is when you 
hold down the Alt key and tap the Tab key.    It takes you to the next open application.)    
Don't worry, you can't Alt+Tab to the Start button or taskbar, or to static icons on the 
desktop.

Un-Topmost The Task Bar: The task bar is sometimes set as a "topmost" window.    
That is, it is always on top of all other windows.    This is not a good idea if your goal is a
secure system, because the user can click on the Start button and run whatever is on 
your system ... exactly what you're trying to avoid.    Fortunately, it's easy to "un-
topmost" the task bar and Start button.

a) Click the Start button
b) Select the Settings menu item.    A sub-menu appears.
c) In the sub-menu, select Taskbar.    The Taskbar Properties dialog comes up
d) Make sure that "Always on top" is NOT checked
e) Click OK to close the Properties dialog



Disable Boot-Time Function Keys: Another possible security hole is the use of the 
function keys when the computer boots.    For example, at boot time F4 starts your 
previous version of DOS, and F8 brings up a menu of options including bare DOS, "safe
mode," and various other ways to continue.    To enhance security, disable these boot-
time function keys with the button in the Setup Options configuration dialog.    To re-
activate, click it again.    The button tells you the current setting.

Don't Use MS-DOS Mode: A few older or ill-behaved DOS programs need to run in 
what's called "MS-DOS Mode."    (It's set in the DOS program's Properties, on the 
Program tab, under Advanced.)    In this mode, Windows 95 starts the program and then
shuts itself down almost entirely.    The DOS program has the use of the entire machine. 
When the DOS program exits, Windows 95 reboots.

If you've put WinU in your Startup folder, as suggested above, it handles this situation 
easily.    WinU restarts smoothly when Windows 95 reboots, and again covers the entire 
screen.    However, while the MS-DOS mode program is running, nothing else is.    Not 
Windows, not WinU, nothing.    So there's no way to enforce timeouts or other security 
considerations.    Windows restarts when the MS-DOS program exits.    It's a complete 
reboot.    Nothing is carried over from the previous Windows session before the MS-
DOS program ran.    At that reboot time, WinU restarts too, because you put WinU in the
Startup folder.    But the new WinU doesn't know what happened "before," so it doesn't 
log the MS-DOS app's exit, it doesn't know to enforce restart control on that app, it 
doesn't know if that app went over its time limit, nothing.

As you can see, MS-DOS Mode creates a large security hole.    Fortunately it's really a 
very small problem, because very few DOS apps require MS-DOS Mode.    Most run just
fine under a normal Windows 95 DOS session.    For those few apps that require it, 
WinU will run the "MS-DOS Mode" apps easily.    All you need to do is check the "MS-
DOS Mode" box in the Apps dialog if you decide to use one of these few problem 
programs.    But before you put one on the menu, consider the security tradeoffs 
involved.
 
Don't Use Programs That Give Access To Your File System:    Some programes 
have their own built-in file management functions.    They let the user use the underlying
directory structure, change or delete files, start other programs, etc.    If security is your 
goal, this is not a good idea.    Sometimes such programs have the ability to disable 
these features.

Change Your Password: An easy way to enhance security is to change your password
often.    Change it to something that isn't obvious, so as to make it difficult to guess.



Differences between Convenience Mode and Security 
Mode
 
Here are the differences between Convenience Mode and Security Mode.

In Security Mode, WinU covers the entire screen all the time.    In Convenience Mode, 
WinU can run smaller than fullscreen.    This simple fact drives almost all the other 
differences.

Since the rest of the system is "available" in Convenience Mode, WinU makes no 
attempt to enforce timeout, warning, or restart restrictions.    The menu does not show 
"Minutes Left" as it does in Security Mode.    If file logging is turned on, application start 
time is logged but not ending time.    (Session start and end times are logged in both 
modes.)    WinU doesn't vigorously resist being shut down abnormally, as in Security 
Mode.

In Security Mode, WinU will run only one program at a time.    If you start a new one, the
old one is terminated.    In Convenience Mode you can run as many programs 
simultaneously as you like.

In Security Mode, when and if WinU closes, it will terminate the currently-running app.    
In Convenience Mode, when WinU closes, any programs it launched continue to run.



Differences Between Evaluation And Registered 
Version
 
There are a number of differences between the trial evaluation version of WinU, and the
the features available after you purchase it.

In the registered version, there are no registration reminder screens when WinU starts 
and exits.    The title bar does not read "UNREGISTERED COPY, FOR EVALUATION 
ONLY."    The text of the warning message box can be set as you choose (no more 
WinU advertising...), and no message box appears when an app terminates.

The registered version lets you set the warning time to something other than three 
minutes, and the termination time to something other than five minutes.

In the registered version, logging to file is available.    If you use this feature, the start 
and end times of each app run from a button, as well as the start and end times ofthe 
session itself, are logged to file.

The registered version does not pause to request that you enter a new password every 
time you start WinU.    The password is saved between sessions.    This makes it much 
more convenient to keep WinU in the Startup folder. 




